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N o t e  t o  S u b t i t l i n g  U s e r s  

In the interest of efficiency, we have combined the captioning and subtitling tutorials into 
a single chapter because they share many common procedures. When we refer to 
captioning, we mean captioning and subtitling unless otherwise noted.  
 
If you are planning to subtitle (where positioning is normally only at the bottom of the 
screen), you need to go through the tutorial in this chapter only in order to understand 
the basics of formatting, positioning and time coding. For features associated with the 
specific subtitling devices (Chyron Codi, DVD, DV2000, or MagniCoder Pro), please 
consult the relevant sections of Chapter 5 of the complete CaptionMaker manual. 

Screen Layout 
There are five major regions of the CaptionMaker screen. (See screenshot on next page.) 
 

1. At the top of the screen, there is a menu bar (File, Edit, View, and so on).  
2. Below the menu bar is the optional edit toolbar (with buttons for file operations, 

text positioning, justification, attributes, and so forth).  
3. At the top left side of the screen is a window that is initially (before a video signal 

is sent to the computer) a blue rectangle. This is called the Video Preview 
Window, or simply the Preview Window.  

4. In the top right corner, the Operations Center, there are four rows of buttons, 
subdivided into regions for Preview Window Operations, Row Operations, VTR 
Control, Miscellaneous Controls and Time code. 

5. At the bottom of the screen is a section called the Work Area. You can navigate 
through this as you would in a spreadsheet, using the mouse and arrow keys. 

Visible Columns 
Make sure that all the columns shown on the following screen are visible on your 
computer screen. If they are not all visible, click on the View menu and check the 
appropriate boxes. You can add additional columns like 
 

• Stop time 
• Time code Duration 
• Words per minute 
• Codi Fonts 

 
Etc. to suit your needs. 
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Computer Display Screen Resolution 
The CaptionMaker works at screen resolutions of 800 x 600 or higher. If your computer 
monitor display is below that, go to Start → Settings → Control Panel → Display and 
change the screen resolution under the Settings tab to at least 800 x 600. 
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CaptionMaker Screen 

Full View or View with Preview Window 
You may switch between two different views of the CaptionMaker screen: 
 

♦ Preview video screen with a few lines of caption/subtitle text, or  
♦ Full view of Caption/Subtitle text with no video screen. 

 
To access these two views, click on the View → Full Screen Spreadsheet from the

menu, or you may click on the Preview Window Switch icon:  
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When you need to watch the video on the computer screen and place the caption/subtitle 
at the appropriate position on the video, use the option Preview Window. When you 
would like to do a large amount of editing and need to see as much text as possible, turn 
off the Preview Window option. 
 
 

Repositioning Preview Window   If you would like to see the full-screen text view 
and the video at the same time, you may click on the Pop-Up Preview Window 
icon  to open up the Preview Window on top of the full screen view and 
position the video screen anywhere you like by simply dragging the window with 
the mouse. 

The Captioning Process 
This chapter concentrates on formatting, positioning and associating time codes with text 
in the context of captioning a video. We also discuss the four display modes for 
captioning: Pop-On, Paint-On, Roll-Up, and Block Roll-Up.  
 
An exhaustive, detailed explanation of all captioning and subtitling capabilities plus an 
explanation of all the menu items and toolbar icons can be found in Chapters 8 and 9. 

Caption Display Modes 
There are four display modes for closed captions: Pop-On, Paint-On, Roll-Up, and Block 
Roll-Up. The first tutorial in this chapter will concentrate exclusively on Roll-Up 
captioning, which is the easiest to learn. Plus it takes less time to caption a video in the 
Roll-Up mode than in the Pop-On or Paint-On modes. You can choose one or multiple 
cell under the Display column, and right click to change the display mode to your choice. 
 
Roll-Up captions are typically used for television news, live events and videos involving 
one person on the screen – typically a classroom lecture or training video. The Pop-On 
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mode is normally used for movies and sit-coms. The Paint-On mode is rarely used. It is 
similar to the Roll-Up mode. Block Roll-Up is a style coined by CPC. All four styles can 
be used within the same captioning job. (See details in this chapter.) 
 
The captioning process can be described in a few steps. Note that the CPC-600 does not 
use time code, and the CPC-700 series does. When time code is discussed in this manual, 
we are referring to use of the CPC-700. 
 

Working with Digital Videos  If you are using CPC-700NL/700NLE, please refer 
to the section Working with Digital Videos near the end of this chapter on how to 
handle a digital video. The following section describes the complete captioning 
process using a videotape as opposed to digital video. All processes are exactly 
the same except handling the digital video and video from a videotape is slightly 
different.  

Entering the Script   
If you do not have a script of the video, you can get the script in many ways, such as:  

♦ If you use a digital video, you can use foot pedal controller vPedal to transcribe 
the video. For details check the page: www.cpcweb.com/Captioning/VPedal-
AllAbout.pdf  

♦ Train a speech recognition software such as Naturally Speaking or ViaVoice 
(www.nuance.com) for a few hours. Then listen to the videotape and repeat the 
dialogue into the microphone. At the beginning, you are going to get lot of errors. 
But you can teach the software to fix the errors and down the road you can expect 
to get about 95% accuracy. For details check this page: 
www.cpcweb.com/Captioning/cap_via_voice.htm  

♦ Dubbing the audio onto a tape and use a Dictaphone® machine can speed up this 
process.  

♦ Use a professional transcription service. This is the most expensive way to 
generate the script. 

 
The CaptionMaker can import scripts from a text file and most word processors (such as 
WordPerfect and Microsoft Word) files. 
 

Transcribing Digital Video  
We do not recommend transcribing your videos from within CaptionMaker. It is much 
better to transcribe the video using WMP with your Word Processor or with the free 
shareware software Express Scribe. 
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We designed CaptionMaker in a way to make it most efficient to import a free form text 
file and break them into individual captions using some simple conditions like: 
1. Maximum caption length (like 28 characters) 
2. Maximum number of lines in each caption (like 2 lines) 
3. Break at punctuation points. 
 
With these types of conditions, CaptionMaker can break a transcript for an hour-long 
video into nice looking captions in a few seconds. 
 
We do not recommend breaking the text into individual captions while you transcribe. 
Let CaptionMaker handle this for you to save you a lot of time. 
 

Transcription Mode If you must transcribe the video within CaptionMaker, there 
is a transcription mode under File menu. Also added an indicator in the status bar 
to indicate when transcription mode is enabled. Transcription mode can be 
enabled/disabled by clicking on this indicator with the mouse.  

When transcription mode is enabled, pressing “Enter” will cause the cursor to 
move down to the next caption cell. If you have the time code stamp active, time 
code is automatically read as the cursor moves to the next cell. 

Transcribe using VPedal with Windows Media Player 
Download and install the Windows Media Player plug-in (free) at: 
http://www.vPedal.com/wmp9.php 
 
Configuring vPedal Media Player Plug-In 

• After you’ve installed it, go to Start >> Programs >>vPedal Media Player Plug-
In >> Direct Launch Plug-In 

• It will open up a tiny Windows Media Player window 
• To begin playing the video simply go to Options >> Open File and change the 

pull-down tab to “All Files” to play the video you wish to transcribe 
• There are no settings or configurations you need to setup. The vPedal will operate 

the play, pause, forward, and rewind functions of the video 
• When you hit pause, and then resume again, the video will skip back 1 second so 

you do not have to rewind 
• To change this skip time to something longer than the 1 second default, go to 

Options >> Settings and change the value in the Release Back Seconds field 
• To change how fast the video plays, go to Options >> Settings and adjust the 

percentage in the Speed field 
•  
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Transcribing in your Word Processor 
• To begin transcribing, simply open your Word Processor and begin typing. The 

vPedal will still control the video even if it is not on top. 
 

• If you want to see the video while transcribing, re-size your word processor to 
give the video enough space to stay on screen while you type. 

 
QuickTime, RealOne Videos 
vPedal cannot control the Quicktime or RealOne videos in Windows. To use VPedal with 
Quicktime or realOne videos, you need to download the codecs that allow you to play 
Quicktime and RealOne videos in Windows Media Player.  
RealPlayer: http://www.free-codecs.com/download/Real_Alternative.htm  
Quicktime: http://www.free-codecs.com/download/QuickTime_Alternative.htm  
 
VPedal has plug-ins to work with iTunes, RealOne, Winamp, and FTR player. To view a 
full list of the plug-ins available for use with VPedal visit 
http://www.vPedal.com/support.htm 

Playing Video 
It makes it very convenient to play video inside CaptionMaker window. You can play 
video coming from a videotape or a digital video (like avi, qt, mpeg, wmv etc.). To play 
video coming from a videotape you would need a video display device like Dazzle DVC-
80. If you use DVC-80, connect the video from the VCR to the yellow jack of DVC-80. 
Connect audio to the sound card, not to the white and red connector on the DVC-80.  
 
Click on the camcorder icon  on the right side of the preview window. Check the box 
Enable External video from a tape. 

Reading Timcode 
If you are using timecode (not available with CPC-600), you need to select the proper 
timecode option. Click on the Timecode >> Timecode Reader Properties or, click on the 

 button and choose the appropriate option. If you are using a video tape, choose an 
external timecode reader. If you are using a digital video, choose Vide Playback.  

Roll-Up Captioning Not Using Time Code 
We will start with Roll-Up captioning without time code. Roll-Up captioning is a good 
starting point because it is the easiest method to learn and use. Because you do not need 
time code, you can even use a VHS tape without time code to caption. In other words, 
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with minimal time, effort and equipment, you can get your feet wet and actually do some 
real captioning.  

Method I: CPC-600/700 Manual Captioning 
1. Transcribe the text from the video. 
2. Import a raw text file. The Import menu offers many formatting features to 

help you break raw text into individual captions. 
3. Manually further refine the imported text into individual captions 
4. Place the captions at a desired screen location and decide if the text is to be 

italicized, underlined or otherwise formatted (requires viewing the video). 
5. Manually send captions to the caption device (Step 4a later in this chapter). 

Transcribing the video 
If you do not have a script of the video, you can get the script in many ways, see the 
section Entering the Script above. 
 
We do not recommend transcribing your videos within CaptionMaker. It is much better to 
transcribe the video first and then import the script into CaptionMaker. 
 
We designed CaptionMaker in a way to make it most efficient to import a free form text 
file and break them into individual captions using some simple conditions like: 
1. Maximum caption length  
2. Maximum number of lines in each caption  
3. Break at punctuation points. 
 
With these types of conditions, CaptionMaker can break a transcript for an hour-long 
video into nice looking captions in a few seconds. We do not recommend breaking the 
text into individual captions while you transcribe. Let CaptionMaker handle this for you 
to save you a lot of time.Importing the script 
 
The CaptionMaker can import scripts from a text file and most word processors (such as 
WordPerfect and Microsoft Word) files. 
 
In Roll-Up captioning, each row in the Work Area equals one caption line of up to 32 
characters. The easiest and most efficient way to begin the process of Roll-Up captioning 
is to enter the dialogue that is on the video into Word (or almost any other word 
processor), and let the computer automatically format each line as you import your script. 
 
See the beginning of the section, “Transcribing and Importing Script” under the “Pop-On, 
Paint-On and Block-Roll-Up Captioning” section later in this chapter to find out how to 
transcribe your text. 
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Assume that you initially entered the text to be captioned into any word processor like 
MS Word. To speed the text entry into Word, the only formatting you need to do in Word 
is to enter periods, commas, semicolons, etc. You do not need to break the text up into 
paragraphs, and certainly do not need to break the text up into individual captions. After 
entering all of the text, you would end up with one giant paragraph, with the text broken 
up into sentences within that paragraph.  
 
Next we will show how the CaptionMaker breaks the text into individual captions at 
sentence punctuations (.?!) automatically. 
 
To illustrate this, we will start with our demo.txt file, which is found on the C:\Program 
Files\CPC\CaptionMaker\Samples folder. After you select the option File → Import and 
choose the file type ASCII text file from the Samples folder and click on the Browse 
button, the computer will prompt you to choose the import file format. Choose the Free 
Form format as shown below and then click on Next. 
 
 
 
 
 
 
 
 
 

Free Form 
 

• Import file where caption/subtitle rows are composed by breaking the text 
into sections based on punctuation (“end-of-sentence”) markers or 
paragraph breaks. 

 
The following dialog box will open. 
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Check the appropriate boxes as shown below and fill-in the necessary boxes. 
Start a row with is a custom character function. This allows you to let CaptionMaker  
start a new row whenever it encounters a particular character while importing text. Note 
that CaptionMaker also properly handles multiple consecutive instances of the character. 
For example, if you select the “>” character, CaptionMaker will start a new row when it 
sees “>”, or “>>”, or “>>>”, etc. 
 
Make sure you break the script into individual captions with the following conditions: 
 

1. Each row made of: 1 line of text 
2. Start of new record: End of sentence punctuation points 
3. Max characters per line: 29 

 

Note on “Each row made of”  The selection of  Each Row made of [1] line(s) of text 
is extremely important. You must always select 1 line per row (cell) when 
captioning in the Roll-Up mode, or else the captions will not roll up properly. 
(The other selections can be changed to meet your specific formatting needs.) 
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The above choices will result in: 
 

1. Each row of text will contain only one line. 
2. Put as many words as possible into each caption cell, until the number of 

characters in the words reaches a maximum of 28. Once that limit is reached, the 
next word becomes the first word of the following caption. 

3. The only exception to the above occurs at the end of a sentence. The first word of 
a new sentence will always become the first word of a caption. The reason for this 
is that captions typically correspond to naturally occurring pauses in speech. And 
at the end of a sentence there is always a pause.  

 
In the example that follows, the second caption consists of only one word, “SCREEN.” 
The reason of course is that it is the last word of the first sentence. 

 
Up to this point text has been entered into a word processor and then imported into the 
CaptionMaker, and we have a text file automatically broken up into individual captions. 
 
The Import Option choices will format the text as follows.  
 

Row H V J Display Caption/Subtitle 
      
1 5 B C Roll-Up 3 I'M AT THE LEFT OF THE 
2 5 B C Roll-Up 3 SCREEN. 
3 5 B C Roll-Up 3 SO CAPTIONS OF WHAT I SAY 
4 5 B C Roll-Up 3 APPEAR AT THE LEFT OF THE 
5 5 B C Roll-Up 3 SCREEN, TOO. 
6 5 B C Roll-Up 3 NOW I'M AT THE RIGHT OF THE 
7 5 B C Roll-Up 3 SCREEN, SO MY CAPTIONS 
8 5 B C Roll-Up 3 APPEAR AT THE RIGHT. 
9 5 B C Roll-Up 3 NOW I AM GOING OFF-SCREEN. 
10 5 B C Roll-Up 3 TO INDICATE THAT I'M 
11 5 B C Roll-Up 3 OFF-SCREEN, WHATEVER I SAY 
12 5 B C Roll-Up 3 IS ITALICIZED. 
13 5 B C Roll-Up 3 NOW MY NAME APPEARS AT THE 
14 5 B C Roll-Up 3 BOTTOM OF THE SCREEN, WE 
15 5 B C Roll-Up 3 PUT CAPTIONS OF WHAT I SAY 
16 5 B C Roll-Up 3 AT THE TOP, SO THAT MY NAME 
17 5 B C Roll-Up 3 IS NOT COVERED BY CAPTIONS. 
18 5 B C Roll-Up 3 UP UNTIL NOW, WE HAVE BEEN 
19 5 B C Roll-Up 3 USING POP-ON CAPTIONS. 
20 5 B C Roll-Up 3 WHEN A NEW CAPTION POPS ON, 
21 5 B C Roll-Up 3 THE OLD CAPTION DISAPPEARS. 
22 5 B C Roll-Up 3 THIS IS A PAINT-ON CAPTION. 
23 5 B C Roll-Up 3 ONE CAPTION BLOCK IS 
24 5 B C Roll-Up 3 PAINTED ON THE SCREEN, FROM 
25 5 B C Roll-Up 3 LEFT TO RIGHT, ONE 
26 5 B C Roll-Up 3 CHARACTER AT A TIME. 
27 5 B C Roll-Up 3 NOW THE ROLL-UP MODE. 
28 5 B C Roll-Up 3 THIS MODE IS NORMALLY USED 
29 5 B C Roll-Up 3 FOR TV NEWS PROGRAMS. 
30 5 B C Roll-Up 3 CAPTION LINES ROLL UP FROM 
31 5 B C Roll-Up 3 THE SCREEN BOTTOM ONE LINE 
32 5 B C Roll-Up 3 AT A TIME. 
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33 5 B C Roll-Up 3 Captions can appear in 
34 5 B C Roll-Up 3 lower case, and also in 
35 5 B C Roll-Up 3 Spanish: ¿Dónde está el 
36 5 B C Roll-Up 3 niño? 
37 5 B C Roll-Up 3 Está en la casa. 
38 5 B C Roll-Up 3 And in French: Parlez-vous 
39 5 B C Roll-Up 3 français? 
40 5 B C Roll-Up 3 Répétez, s'il vous plâit. 
41 5 B C Roll-Up 3 THE FOLLOWING SPECIAL 
42 5 B C Roll-Up 3 CHARACTERS ARE ALSO 
43 5 B C Roll-Up 3 AVAILABLE. 
44 5 B C Roll-Up 3 á é í ó ú à è ì ò ù ä ë ï ö 
45 5 B C Roll-Up 3 ü â ê î ô û THEY INCLUDE 
46 5 B C Roll-Up 3 THE MUSIC SYMBOL AND 
47 5 B C Roll-Up 3 ACCENTED CHARACTERS. 
48 5 B C Roll-Up 3 ç ã ñ õ å ¿ ¡ ¢ £ ¥ © ® ™ ° 
49 5 B C Roll-Up 3 ß § 

 
 
For instructive purposes, we purposely inserted two sections in which the text should be 
further refined to improve the appearance of the captions. In the CaptionMaker directory, 
there is a file called Demo-R.cap. Open this file into the CaptionMaker using the Open 
option under the File menu as opposed to the Import option. This file is slightly different 
from the file shown above. We further refined the lines 35 through 49 using Push and 
Pull functions (See “Step 2: Refining Text into Captions” later in this chapter.) 
 

35 5 B C Roll-Up 3 Spanish:  
36 5 B C Roll-Up 3 ¿Dónde está el niño? 
37 5 B C Roll-Up 3 Está en la casa. 
38 5 B C Roll-Up 3 And in French: 
39 5 B C Roll-Up 3 Parlez-vous français? 
40 5 B C Roll-Up 3 Répétez, s'il vous plâit. 
41 5 B C Roll-Up 3 THE FOLLOWING SPECIAL 
42 5 B C Roll-Up 3 CHARACTERS ARE ALSO 
43 5 B C Roll-Up 3 AVAILABLE. 
44 5 B C Roll-Up 3 á é í ó ú à è ì ò ù  
45 5 B C Roll-Up 3 ä ë ï ö ü â ê î ô û  
46 5 B C Roll-Up 3 THEY INCLUDE THE MUSIC SYMBOL 
47 5 B C Roll-Up 3 AND ACCENTED CHARACTERS. 
48 5 B C Roll-Up 3 ç ã ñ õ å ¿ ¡ ¢ £  
49 5 B C Roll-Up 3 ¥ © ® ™ ° ß § 

 

Also notice the Horizontal (H) and Display columns. We also changed all the cells under 
the Horizontal column to 5. This is done by left-clicking on the header H of the 
Horizontal column and right-clicking on any cell under H and choosing 5 from the option 
Other. This gives us a left indentation of 4 characters: the captions start at the fifth 
column. Remember we chose 28 characters as the maximum caption length. Added to the 
indentation of 4 characters, this makes a total length of 32, which is the maximum 
allowable length from the left side of the screen to the right. 
 
We also need to change the Display Mode to Roll-Up. Left-click on the header Display. 
Now right-click on any cell under Display and choose Roll-Up 3 Lines. This will change 

 15



all the cells to Roll-Up 3. This selection will display a maximum of 3 lines of captions on 
the video at any given time.  
 
Finally, to see captions on the video screen for the text above, we have provided a 
videotape to be used with this tutorial. This tutorial text starts at about 3.5 minutes from 
the beginning of the video right after this screen: 
 

Now we will show you 
how the CaptionMaker 

software works. 
 
As you view the segment starting at burn-in time code 00:19:55:04 on the top left corner 
of the video, you will see our narrator Valerie on the left of the screen. Ignore the 
different positions of the narrator. Positioning captions on the screen above or below the 
person is used for Pop-On and Paint-On caption modes. 
 
For the rest of the captioning job, follow Step 4a for non-time code captioning later in the 
manual. Steps 4b and 5 are used for time code-based captioning.  
 

Notes on Roll-Up Captioning 
1. Pop-On and Paint-On captions can be placed in any of 15 rows on the video 

screen and can have a maximum of 32 characters. But Roll-Up captions can be 
placed in only the first 4 rows and last 4 rows on the video screen. To place Roll-
Up captions anywhere within these allowable rows, you need to right-click on the 
cell under the V Column and choose from the choices Top, Bottom, Other (Not 
Center). If you choose Other, you may choose 1, 2, 3, 4 or 12, 13, 14 and 15. The 
first row is same as T (Top) and the 15th row is same as B (Bottom). You may 
highlight a number of cells under the V column and right-click on it to change the 
row position for a number of rows in one stroke. 

2. Roll-Up captioning is available for 2, 3 or 4 lines of captioning. When you choose 
any one of these modes, you will see a maximum of 2, 3 or 4 lines of text on the 
video monitor. Make a note that Preview Window will still show only one line of 
text. 

3. When you press the [+] key to send the captions one line at a time, the text starts 
to appear on the video screen immediately, one character at a time. This makes it 
feasible to caption a video on the fly. You can work without time code if you 
wish. On the other hand, if you choose Pop-On mode, you will notice that there is 
a delay of a second or so for the caption to appear after you press the [+] key. It is 
not possible to use Pop-On caption mode without time code. Use of time code 
fixes the delay problem internally as will be explained later. 

4. You may use the Block-Roll-Up captioning mode to give the same feel as the 
Pop-On or Paint-On caption mode. Captions go out on the fly immediately as you 
press the [+] key. You can also position the captions to the left, center and right. 
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To use Block-Roll-Up mode, you must have more than one line of text in one row 
under the Caption/Subtitle column. (See section under “Pop-On, Paint-On 
Block-Roll-Up Captioning” later in the manual.) 

5. If there is more than one person on the video screen, to distinguish the speakers, 
you need to use the following technique. Use the symbol  

 

> for the first person and  
>>  for the second person 
>  for the third person (if exists) or for the first person. 
 

The use of > and >> alternatively distinguishes one speaker from the other.  
 

> Speaker one talking 
Speaker one still talking 
Speaker one still talking 
Speak one still talking 
>> Speaker two talking 

Speaker two still talking 
> Back to speaker one  

Speaker one still talking 
>> Speaker three talking 

 
  
 

6. Keep in mind that the maximum number of characters you can fit in one line is 
32. So if you have an indentation of 4 characters (horizontal position H = 5), and 
like to put one or two > symbols for change of speakers, you should import the 
original text file with no more than 25 ( = 32 – 4 – 3) characters per row. 

7. To clear captioning from the screen when there is no one speaking for more than 
3 seconds or so, you can clear the captions by inserting blank row. 

 
 

Reformatting Captions  After you import a file and work on it for Pop-on or Roll-
up display modes, if you change your mind, you may use 3 reformat functions 
from the Format menu to change the file for Pop-On or Roll-Up modes. See the 
section Reformat Rows in Chapter 8: Menus for details. 
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Pop-on, Paint-On and Block-Roll-Up Captioning 

Method II: CPC-600/700 Manual Captioning 
1. Import a raw text file. The Import menu offers many formatting features to help 

you break raw text into individual captions. 
2. Manually further refine the imported text into individual captions 
3. Place the captions at a desired screen location and decide if the text is to be 

italicized, underlined or otherwise formatted (requires viewing the video). 
4. Manually send captions to the caption device (Step 4a). 

 

Method III: CPC-700 AutoSync Captioning with Time 
Code 
CPC-700 offers all of the functionality of CPC-600, so you can use Method I, II, III or 
IV. 

1. Import a raw text file. The Import menu offers many formatting features to 
help you break raw text into individual captions. 

2. Manually further refine the imported text into individual captions. 
3. Place the captions at the desired screen location and decide if the text is to be 

italicized, underlined or otherwise formatted. 
4. Associate time code on the video with each caption (Step 4b). 
5. AutoSync captions with the video using time code (Step 5a). 

 

Method IV: CPC-600/700 AutoSync Captioning with PC 
System Timer 

1. Import a raw text file with special formatting. The Import menu offers many 
formatting features to help you break raw text into individual captions. 

2. Manually further refine the imported text into individual captions 
3. Place the captions at the desired screen location and decide if the text is to be 

italicized, underlined or otherwise modified. 
4. Manually associate PC System Timer time stamps with captions (Step 4c). 
5. AutoSync captions with the video using time stamps. (Step 5b). 

 
Sample text files are included with CPC software for use in the tutorial. These files will 
help illustrate how you will go through each step to create the final formatted file with 
time code from a raw text file These files are located in the home directory of the 
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CaptionMaker (usually C:\Program Files\CPC\CaptionMaker). The caption script files 
supplied are: 

 

Filename Description 
Demo.txt Raw text (ASCII text). 
Demo1.cap After opening Demo.txt in the CaptionMaker, the file looks like 

this. (Step 1) 
Demo2.cap After breaking up text into individual captions (Step 2). 
Demo3.cap After positioning captions on the screen (Step 3). 
Demo.cap 
Demo-R.cap 

After associating time codes with each caption (Step 5). 
Demo text formatted for Roll-up captions. 

Step 1: Transcribing and Importing Script 
If you do not have a transcript of the video, read the section Entering the Script at the 
beginning of this chapter. 
 

For this tutorial you have a file Demo.txt in the folder C:\Program Files\CPC\ 
CaptionMaker\ Samples folder, so you do not need to transcribe it. Import the file by 
using File → Import option. Choose Files of Type as ASCII Text Files (*.txt) and the 
make sure that Look In folder is C:\Program Files\CPC\CaptionMaker\Samples in order 
to have the icon for Demo.txt appear. Double-click on the Demo.txt icon. 
 
See Chapter 3 for details on importing various kinds of word processor files. 

Import Dialog Box 
The Import ASCII File dialog box will appear, which gives you several options (see 
graphic on next page). 

 

1. Select the first option, Free Form. 
2. Under Options, choose the end-of-sentence punctuation option (radio button). 
3. Under Options, choose the default settings for the maximum characters per line 

(default is 26) and the maximum number of lines per cell (default is 2). The 
CaptionMaker will use these last two factors to break the text into different cells.  

4. Make sure the Square-up text box is checked. Press the OK button. 
 
 
 

 

Free Form 
 

• Import file where caption/subtitle rows are composed by breaking the text 
into sections based on punctuation (“end-of-sentence”) markers or 
paragraph breaks. 
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Check the appropriate boxes as shown below and fill-in the necessary boxes. 
Start a row with is a custom character function. This allows you to let CaptionMaker  
start a new row whenever it encounters a particular character while importing text. Note 
that CaptionMaker also properly handles multiple consecutive instances of the character. 
For example, if you select the “>” character, CaptionMaker will start a new row when it 
sees “>”, or “>>”, or “>>>”, etc. 
 
End a row with is a custom character function. This allows you to let CaptionMaker end 
the current row whenever it encounters a particular character while importing text. For 
example a new caption starts after the phrase [applause]. 

 

Tip   Even though one caption line can hold a maximum of 32 characters, it is 
customary to limit captions to around 26, which is the default used in this 
program. If you play with numbers between 24 and 32 you will see how the 
appearance can vary. 

 20



The Demo.txt File 
If you were to examine the file (in Notepad, for example) before import, it would look 
like this 
 

I'M AT THE LEFT OF THE SCREEN. SO CAPTIONS OF WHAT I SAY APPEAR AT 
THE LEFT OF THE SCREEN, TOO. NOW I'M AT THE RIGHT OF THE SCREEN, 
SO MY CAPTIONS APPEAR AT THE RIGHT. NOW I AM GOING OFF-SCREEN. TO 
INDICATE THAT I'M OFF-SCREEN, WHATEVER I SAY IS ITALICIZED. NOW MY 
NAME APPEARS AT THE BOTTOM OF THE SCREEN, WE PUT CAPTIONS OF WHAT 
I SAY AT THE TOP, SO THAT MY NAME IS NOT COVERED BY CAPTIONS. UP 
UNTIL NOW, WE HAVE BEEN USING POP-ON CAPTIONS. WHEN A NEW CAPTION 
POPS ON, THE OLD CAPTION DISAPPEARS. THIS IS A PAINT-ON CAPTION. 
ONE CAPTION BLOCK IS PAINTED ON THE SCREEN, FROM LEFT TO RIGHT, 
ONE CHARACTER AT A TIME. NOW THE ROLL-UP MODE. THIS MODE IS 
NORMALLY USED FOR TV NEWS PROGRAMS. CAPTION LINES ROLL UP FROM THE 
SCREEN BOTTOM ONE LINE AT A TIME. Captions can appear in lower 
case, and also in Spanish: ¿Dónde está el niño? Está en la casa. 
And in French: Parlez-vous français? Répétez, s'il vous plaît. THE 
FOLLOWING SPECIAL CHARACTERS ARE ALSO AVAILABLE. á é í ó ú à è ì ò 
ù ä ë ï ö ü â ê î ô û THEY INCLUDE THE MUSIC SYMBOL AND ACCENTED 
CHARACTERS. ç ã ñ õ å ¿ ¡¢ £ ¥ © ® ™ ° ß § 

 

The Demo1.cap File 
After importing the file, the computer screen should look like this. If it doesn’t, check to 
make sure you imported the correct file. 
 

Row H V Caption/Subtitle 
    
1 B C I'M AT THE LEFT 

OF THE SCREEN. 
2 B C SO CAPTIONS OF WHAT I SAY 

APPEAR AT THE LEFT OF THE 
3 B C SCREEN, TOO. 
4 B C NOW I'M AT THE RIGHT 

OF THE SCREEN, SO MY 
5 B C CAPTIONS APPEAR 

AT THE RIGHT. 
6 B C NOW I AM GOING OFF-SCREEN. 
7 B C TO INDICATE THAT I'M 

OFF-SCREEN, WHATEVER I 
8 B C SAY IS ITALICIZED. 
9 B C NOW MY NAME APPEARS 

AT THE BOTTOM OF THE SCREEN, 
10 B C WE PUT CAPTIONS OF WHAT I 

SAY AT THE TOP, SO THAT 
11 B C MY NAME IS NOT 

COVERED BY CAPTIONS. 
12 B C UP UNTIL NOW, WE HAVE 

BEEN USING POP-ON 
13 B C CAPTIONS. 
14 B C WHEN A NEW CAPTION POPS 

ON, THE OLD CAPTION 
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15 B C DISAPPEARS. 
16 B C THIS IS A 

PAINT-ON CAPTION. 
17 B C ONE CAPTION BLOCK IS 

PAINTED ON THE SCREEN, 
18 B C FROM LEFT TO RIGHT, ONE 

CHARACTER AT A TIME. 
19 B C NOW THE ROLL-UP MODE. 
20 B C THIS MODE IS NORMALLY 

USED FOR TV NEWS PROGRAMS. 
21 B C CAPTION LINES ROLL UP 

FROM THE SCREEN BOTTOM 
22 B C ONE LINE AT A TIME. 
23 B C Captions can appear in 

lower case, and also in 
24 B C Spanish: ¿Dónde 

está el niño? 
25 B C Está en la casa. 
26 B C And in French: 

Parlez-vous français? 
27 B C Répétez, s'il vous plaît. 
28 B C THE FOLLOWING SPECIAL 

CHARACTERS ARE ALSO 
29 B C AVAILABLE. 
30 B C á é í ó ú à è ì ò ù ä 

ë ï ö ü â ê î ô û THEY 
31 B C INCLUDE THE MUSIC SYMBOL 

AND ACCENTED CHARACTERS. 
32 B C ç ã ñ õ å ¿ ¡ ¢ 

£ ¥ © ® ™ ° ß § 

 
 

TIP FOR FORMER DOS CAPTIONMAKER USERS: BREAKING LINES  In previous DOS 
versions of the CaptionMaker, you had a “break lines” feature and used the Enter 
key to send captions out. The Windows version is different. The work of the 
“break lines” feature is done automatically when the text is imported into the 
CaptionMaker, and moving text between captions is performed by clicking on a 
variety of buttons when a row of the Work Area is selected, not by using the 
Enter key (though use of it will not harm existing formatting). There is no longer 
any special meaning to the backslash ( \ ) key.  

 
To scroll through text, use the scroll bar on the right side of the screen. Don’t worry if 
you can’t see all of the text in a cell. If you click inside the cell and press the down arrow, 
it should appear.  
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Step 2: Refining Text Into Captions 

General Guidelines 
You should now have the Demo.txt file loaded into the CaptionMaker. The Demo.cap file 
has the same information as the Demo.txt file, except now it is broken up into different 
cells. 
 
Next you will further format the script into individual captions. An individual caption 
contains the text that will be sent to the screen when that row is selected, either by 
manual synchronization or by AutoSync. One row of cells in the Work Area corresponds 
to a caption. Make sure that you have set the computer for captioning. To do this, go to 
Caption → Device. 
 

Note  A caption can accommodate up to 4 lines of text with up to 32 characters on 
each line. When the menu bar indicates that the program is configured to Caption, 
the computer will enforce this requirement. The restrictions for subtitling are less 
stringent. 

 
The process of conversion of the raw script into captions uses the four Row Operations 
buttons, and the five Processing icons (U, D, C, E, A) in the Work Area. To use a button, 
click on the row of text in the Work Area you would like to work on, and then click the 
formatting button that you would like to use.  
 
 

TIP FOR FORMER DOS CAPTIONMAKER USERS: Preview and Edit Mode  The Windows 
software does not have separate Preview and Edit modes, as used in the DOS 
software. With the Windows software, you select both the words that will appear 
in a caption and how many lines each caption will contain all at once. 

Operations Center: Row Operations 
Helps you manipulate the number of 
captions in your captioning job. The 
Demo.txt file initially has 22 captions 
in it; when we are done with the Row 
Operations we will have 30. 
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   Insert Row 
This button will insert a row above the currently selected row. Hint: If you need to insert 
a row at the very bottom, click at the very end of the last cell and use the Split Cell 
button. 

   Delete Row 
This button will remove the currently selected row (the row where the cursor is).  

   Merge Cells 
This button will merge all selected cells into a single cell. (More than one cell needs to be 
selected for this feature to work.) 

   Split Cell 
The Split Cell button will split the currently selected cell into two cells at the point where 
the cursor blinks. 
 

Highlighting Multiple Rows and Cells  
You may highlight a number of rows or cells to change attributes, such as Horizontal 
Position, Justification or Display Mode for the selected multiple rows or cell. The 
highlighting of multiple rows or cells can be accomplished in a number of ways. Here are 
a few examples. 
 
To highlight all the cells 
under column H and change 
the Horizontal position of 
rows to L (left). 

Click on the Heading H and then right-click and choose L 

To highlight rows 2 through 
5 and change the Display to 
Paint-On. 

Click on 2 under the heading #. Hold the Shift key and click 
on 5. This will highlight all 4 rows 2 through 5. Now right-
click on any cell under the heading Display and choose Paint-
On with a left-click. 

To selectively highlight 
rows 2, 4 and 7 and change 
the Vertical position to Top. 

Click on 2 under the heading #. Hold the Ctrl key and click 
on 4, then 7. This will highlight all 3 rows 2, 4 and 7. Now 
right-click on any of the three highlighted cells under the 
heading V and choose T for Top position. 

To highlight 3 text cells 
(rows 2 through 4) under the 
heading Caption/Subtitle 
and change text to italics. 

Click the mouse somewhere other than cell 1. Now click the 
mouse on cell 1 and without releasing the button, drag the 
mouse downward to cell 4. This will highlight 3 text cells 
(rows 2 through 4). Now Click on the Italics tool button. 

To highlight text within cell 
4 under the heading 
Caption/Subtitle and change 
the text to underline. 

Click the mouse on cell 4. Click again on the starting point of 
the text area you would like to highlight and without releasing 
the button, move the mouse to cover the text you would like 
to highlight. Then click on the Underline tool button. 
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Work Area Icons 

The icons in the Work Area to the left of the text include, 
in order, Pull next Cell’s First Word Up , Push Last 
Word Down , Compress Text , Expand Text , and 
Alternate Break . Each icon, when clicked, will change 
the text in the row that the cursor is on. 
 
Pull First Word and Push Last Word work between two 
cells. Changes occur at the end of the text in the current 
cell and at the beginning of the following cell. 
 
On the other hand, Compress Text, Expand Text, and 
Alternate Break operate within a cell. 
 

 

    Pull First Word (U) 
The Pull First Word icons are under the column heading U. This will take the first word 
from the cell below and move it up to the end of the cell with the cursor. If the cursor is 
on the first cell: 
 

I’M AT THE LEFT OF THE SCREEN. 
 
and you click on the  icon, the first word of the next row will be pulled up: 
 

I’M AT THE LEFT OF THE SCREEN. SO 
  

    Push Last Word (D) 
The Push Last Word icon is under the column heading D. This will take the last word 
from the cell the cursor is on, and move it down to the beginning of the next cell. If the 
cursor is on the first cell, 
 

I’M AT THE LEFT OF THE SCREEN. SO 
 

and you click on the  icon, the last word will be moved down to the next line, changing 
the cell to this:  
 

I’M AT THE LEFT OF THE SCREEN. 
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Note   If you push all the text out of a cell it will be blank, and should then be 
deleted using the Delete Row button, which can be found in the Row Operations 
section of the Operations Center. 

 

 Compress Text (C) 
The Compress Text icon reduces the left and right margins of the cell the cursor is on to 
squeeze the text into a smaller area. If you click on the Compress Text icon on the first 
cell, you will get: 
 

I’M AT THE LEFT OF THE  
SCREEN. 

 
Clicking the Compress Text icon a second time, you will get: 
 
 

I’M AT THE LEFT OF  
THE SCREEN. 

 
If you click the icon 4 more times, the cell will reach its maximum compression of 4 
lines: 
 

I’M AT 
THE LEFT 
OF THE 
SCREEN. 

 

If you click the icon  again, nothing further will happen. You cannot have more than 4 
lines per caption. 
 

   Expand Text (E) 
The Expand Text icon increases the margins within a cell and decreases the number of 
lines. It is the reverse of the Compress Text function. If you click on this icon on the first 
cell, which looks like the previous box above, you will get: 
 

I’M AT THE  
LEFT OF  

THE  
SCREEN. 

 
If you click the icon 4 more times you will get: 
 
 

I’M AT THE LEFT OF THE  
SCREEN. 
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Nothing further will happen when you click the icon again. 
 

   Alternate Break (A) 
Clicking on the Alternate Break icon results in changing the way that text is stacked 
within a cell, by alternating whether the top or the bottom line should display more text. 
Suppose the first cell looks like this: 
 

I’M AT THE LEFT OF THE  
SCREEN. 

 
When you click on the Alternate Break icon, the cell will look like this: 

 
I’M AT THE  

LEFT OF THE SCREEN. 

 
If you click on the icon twice more, the text will square up: 
 

I’M AT THE LEFT  
OF THE SCREEN. 

 
 

TIP FOR FORMER DOS CAPTIONMAKER USERS:  Deleting a Line  Using CaptionMaker 
for DOS, if you deleted all of the information on a line, and hit delete one more 
time, you could completely eliminate a line. You cannot do this in the Windows 
version. In order delete a line, you must use the Delete Row button in the 
Operations Center. 

 

Working with the File Demo1.cap: 
Let’s work on the first three cells that look like this: 
 

1 I'M AT THE LEFT  
OF THE SCREEN. 

2 SO CAPTIONS OF WHAT I SAY  
APPEAR AT THE LEFT OF THE 

3 SCREEN, TOO. 

 
And suppose we would like the cells to look like this: 
 

1 I'M AT THE LEFT  
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OF THE SCREEN. 
2 SO CAPTIONS  

OF WHAT I SAY  
3 APPEAR AT THE LEFT  

OF THE SCREEN, TOO. 

 
First click 6 times on the Row 2 Push Last Word icon so that 6 words from the end of 
Row 2 move to the beginning of Row 3. Then click on the Compress icon on each row 
several times until you see the cells look like the above table. If you make a mistake, 
click on the appropriate icon to fix the mistake. Manipulating text using the Work Area 
icons will quickly become second nature.  
 
In the process of breaking the text into different cells, you may need to create new rows 
and delete blank rows. If you need to create a new row above a row, click the mouse on 
that row and click the Insert Row(s) button in the Operations Center. If you need to delete 
a blank row, click on the Delete Row(s) button next to it.  
 

The Demo2.cap File 
After working with all the cells you will create a file, which should look like this: 
 

Row H V Caption/Subtitle 

    
1 B C I'M AT THE LEFT 

OF THE SCREEN. 
2 B C SO CAPTIONS 

OF WHAT I SAY 
3 B C APPEAR AT THE LEFT 

OF THE SCREEN, TOO. 
4 B C NOW I'M AT THE 

RIGHT OF THE SCREEN, 
5 B C SO MY CAPTIONS 

APPEAR AT THE RIGHT. 
6 B C NOW I AM GOING 

OFF-SCREEN. 
7 B C TO INDICATE THAT 

I'M OFF-SCREEN, 
8 B C WHATEVER I SAY 

IS ITALICIZED. 
9 B C NOW MY NAME APPEARS 

AT THE BOTTOM OF THE SCREEN, 
10 B C WE PUT CAPTIONS OF 

WHAT I SAY AT THE TOP, 
11 B C SO THAT MY NAME IS NOT 

COVERED BY CAPTIONS. 
12 B C UP UNTIL NOW, WE HAVE BEEN  

USING POP-ON CAPTIONS. 
13 B C WHEN A NEW CAPTION POPS ON, 

THE OLD CAPTION DISAPPEARS. 
14 B C THIS IS A 

PAINT-ON CAPTION. 
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15 B C ONE CAPTION BLOCK IS 
PAINTED ON THE SCREEN, 

16 B C FROM LEFT TO RIGHT,  
ONE CHARACTER AT A TIME. 

17 B C NOW THE ROLL-UP MODE. 
18 B C THIS MODE IS NORMALLY 
19 B C USED FOR TV NEWS PROGRAMS. 
20 B C CAPTION LINES ROLL UP 
21 B C FROM THE SCREEN BOTTOM. 
22 B C ONE LINE AT A TIME. 
23 B C Captions can appear 

in lower case, 
24 B C and also in Spanish: 
25 B C ¿Dónde está el niño? 
26 B C Está en la casa. 
27 B C And in French: 
28 B C Parlez-vous français? 
29 B C Répétez, s'il vous plaît. 
30 B C THE FOLLOWING SPECIAL 

CHARACTERS ARE ALSO AVAILABLE. 
31 B C á é í ó ú à è ì ò ù ä 

ë ï ö ü â ê î ô û 
32 B C THEY INCLUDE THE MUSIC SYMBOL 

AND ACCENTED CHARACTERS. 
33 B C ç ã ñ õ å ¿ ¡ ¢ 

£ ¥ © ® ™ ° ß § 

 

Step 3: Caption Position and Attributes 
During this step, you will be watching the video to see where the speakers are on the 
screen. We must also decide two things. 
 

1. We must decide where on the screen the caption should go. Should the caption be 
at the top of the screen or the bottom of the screen? The left of the screen, or the 
right of the screen? Simultaneously, we will select the justification of the text on 
the screen, from among the choices of left, center and right.  

2. Finally, some text should be underlined and other text should be italicized. 
(Italicized typically indicates an off-screen narrator.) You can apply these 
attributes to the text at this point in the process. 

 

Positioning of Captions on the Screen 
In order to accurately position captions on the screen, you need to be aware of what the 
computer screen is telling you about the caption positions. 
 
The Preview Window accurately portrays the way captions will appear on your final 
video. This is in contrast to a cell in the Work Area, which cannot represent the vertical 
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location of a caption on the TV screen – it is one-dimensional, and the TV screen is two-
dimensional.  
 
If you have enabled the Horizontal Position and Vertical Position in the Visible Columns 
dialog box (View menu), you can figure out the position on the screen by looking at the 
numbers. The top of the screen starts at 1 (vertical position), and the left of the screen 
starts at 1 (horizontal position). The maximum number of lines is determined when you 
choose subtitling or captioning. Basic left/center/right and position can be set along with 
justification by clicking a single button, as explained below under “Justification”. You 
can also set position (not justification) of a single caption by clicking and dragging the 
caption inside of the Preview Window with the mouse.  
 

       Justification  
You will note that the buttons on the toolbar for left, center and right, have a blue L, a 
green C, and a red R at the top of the button. By default, these buttons do the following: 

 
 
 

Icons Preview Window Result 
(Left Position, Left Justification) 

 

 

 
 
 
 
SO CAPTIONS OF 
WHAT I SAY 

(Center Position, Center Justification) 
 

 

 
 
 
 

SO CAPTIONS OF 
WHAT I SAY 

(Right Position, Right Justification) 
 

 

 
 
 
 

SO CAPTIONS OF 
WHAT I SAY 

The Preview Window (shown on the right) shows relative position of different captions. 

 
 

# H V J Caption/Subtitle 

2 L B L SO CAPTIONS OF 
WHAT I SAY 

2 C B C SO CAPTIONS OF 
WHAT I SAY 

2 R B R SO CAPTIONS OF 
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WHAT I SAY 

The Work Area shows how rows within each caption appear in relation to each other. The 
other positioning data, Horizontal (H), Vertical (V) and Justification (J) data are displayed 
in their respective columns. 
 

 
You will note that each of the justification buttons do two different things to the text: 
 

1. They set text at a horizontal position on the screen –left, center and right. (The 
colored letter on the button (L, C or R) indicates this information, and they always 
stay in the order L, C, R on the toolbar.) 

2. Each of the three buttons also set the appropriate justification of the lines (in other 
words, whether lines are flushed left, centered or flushed right), regardless of the 
lines’ horizontal location.  

 

By default, the three buttons will produce the justifications that shown on the previous 
table: The Left button, for instance, will left justify the text, such that if you have two 
lines, both of them will start flush left. However, you can change these defaults. For more 
information, see “Chapter 8: Menus”. 

Vertical Position: 
In captioning, there are only 15 possible vertical positions, which are numbered 1 through 
15. To change a vertical position you can: 
 

1. Use the mouse to move the caption in the Preview Window. The caption will snap 
to the nearest valid screen position. 

2. Type in a number from 1 to 15 in the Vertical Position column in the appropriate 
row. The computer will not let you enter an invalid number. 

3. Right-click on the Vertical Position cell on the appropriate row. Select the general 
position or other numeric value for the vertical position. 

 
If you would like to change multiple vertical positions, you can select multiple cells by 
using Shift + click or Ctrl + click, and performing the right-click operation on a Vertical 
Position cell in the selected group. 

 

Attributes: Choosing Italics, Underline and Color 
Select text within a cell by using the mouse, and then click the Italic or the Underline 
button on the toolbar. The text in that cell will change and can be displayed as italicized 
or underlined on the screen.  
 
You may also apply the following color and other attributes to emphasize a single word 
or the whole caption (See details in Chapter 8: Menus.) 
 

♦ Normal: On-screen speakers 
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♦ Italics: Off-screen narrators 
♦ Underline: Emphasis 

 

Working with Demo2.cap 
We have provided a videotape to be used with this tutorial. This tutorial text starts at 
about 3.5 minutes from the beginning of the video right after this screen (as of August 
2002):  
 

Now we will show you 
how the CaptionMaker 

software works. 
 
As you view the segment starting at burn-in time code 00:19:55:04, you will see our 
narrator, Valerie on the left of the screen speaking. Our narrator speaks slowly and 
distinctly on this tape. This is not the case for most captioning jobs. You should place this 
caption on the left margin under her so it is clear to the viewer that she is speaking. 

Lines 1-3: Left Position 
Let’s work on the first three cells that look like this: 
 

# H V J Caption/Subtitle 
1 L B L I'M AT THE LEFT 

OF THE SCREEN. 
2 L B L SO CAPTIONS  

OF WHAT I SAY 
3 L B L APPEAR AT THE LEFT  

OF THE SCREEN, TOO. 

 
Watching the video, we know that these 3 captions are to be placed on the left side of the 

screen. Click on the text area of Row 1 and then click on the Left position button  on 
the toolbar. The text will move to the left side on the Preview Window. Nothing will 
change on the Work Area screen. You can also click on the caption inside the Preview 
Window and drag the caption to any location you prefer.  
 
You may also change the position of all three rows by first highlighting the three rows. 
Click on the row number 1 in the far left column; then hold the Shift key and click on the 
row number 3. This operation will highlight rows 1-3. Now click on the Left position 
button on the toolbar. This will position text of all three rows on the left side of the 
screen.  

Lines 4 and 5: Right Position 
Now Valerie is on the right side of the screen, so you need to place the caption under her 
at the right. 
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Click on the row number 4, then hold the Shift key and click on the row number 5.  
This will highlight rows 4 and 5. Now click on the Right position button on the toolbar. 
This will position text of both rows 4 and 5 on the right side of the screen. Note the 
horizontal position under the column H has changed from C (center) to actual numbers.  
 

# H V J Caption/Subtitle 
4 R B R NOW I'M AT THE 

RIGHT OF THE SCREEN, 
5 R B R SO MY CAPTIONS 

APPEAR AT THE RIGHT. 

 

Lines 6-8: Italics  
Now Valerie is off-screen. Captions of an off-screen narrator are displayed in italics. 
 
Click on the row number 6 in the far left column, then hold the Shift key and click on the 
button number 8. This operation will highlight three cells: 6, 7 and 8.  
 
Now click the Italic button on the toolbar. The text in both the Work Area and the Video 
Preview Window should change to italic. In general, captioning style dictates that an off-
screen narrator’s captions appear in italic. But in cases where the narrator goes on and off 
the screen, you could get by without using italic attributes. 
 

6 C B C NOW I AM 
GOING OFF-SCREEN. 

7 C B C TO INDICATE THAT 
I'M OFF-SCREEN 

8 C B C WHATEVER I SAY 
IS ITALICIZED. 

 

Clearing the Screen of Captions    A blank row clears (erases) existing captions on 
the video screen. This is the only way CaptionMaker can clear the screen. The 
start time of the blank row is the time at which the screen will be cleared. 

 

Lines 9-11: Top Positioning  
Captions 9 through 11 should be at the top of the screen because Valerie’s name appears 
at the bottom of the screen. You should also use the normal font since she is visible.  
 
Click on the row number 9 in the far left column, then hold the Shift key and click on the 
number 11. This operation will highlight three cells: 9, 10 and 11. Now right-click on any 
one of the three cells under the heading V (Vertical position) and choose Top. 
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Lines 12-13: No Need to Do Anything 
 

Lines 14-16: Paint-On Mode  
You may have programs where you can mix caption display modes. Lines 14 through 16 
are to be displayed in the Paint-On mode. 
 
Highlight these three cells and right-click on the Display column of any one of the three 
rows and left-click on Paint-On. The cells under Display column should now show 
“Paint-On” as shown below. 
 

14 C B C Paint-On THIS IS A 
PAINT-ON CAPTION. 

15 C B C Paint-On ONE CAPTION BLOCK IS 
PAINTED ON THE SCREEN, 

16 C B C Paint-On FROM LEFT TO RIGHT, 

 

TIP FOR FORMER DOS CAPTIONMAKER USERS: Changing Modes  In the DOS 
software, you would change from Pop-On to Paint-On mode by having a special 
control character sitting by itself on a line (such as ^T). In the Windows version 
on the row where you would like the change to take place, go to Attribute → 
Display Mode  and select the display mode for that row only, or right-click on the 
Display column in the Work Area and pick from the pull-down menu. 

 
Lines 17-22: Roll-Up Mode 
Captions 17 through 22 have already been formatted for the Roll-Up mode. Note that for 
the Roll-Up mode, each cell should contain only one line. 
 
Highlight these six rows and right-click on the Display column of any one of the six rows 
and left-click on Roll-Up.  
 
Again highlight these six rows and right-click on the Horizontal column of any of the six 
rows and left-click on Other to choose 4. The captions will be indented 4 characters from 
the left. Remember you can put a maximum of 32 characters on a caption line. For 
example, if you use 4 characters left indentation, you can have only 28 characters on that 
line. 
 
While the six rows are highlighted, right-click on the Justification column in any one of 
them and left-click on Left Justify. 
 
The cells under the Horizontal, Justification and Display columns should reflect all the 
changes you have made as shown below. 
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17 5 B L Roll-Up NOW THE ROLL-UP MODE. 
18 5 B L Roll-Up THIS MODE IS NORMALLY 
19 5 B L Roll-Up USED FOR TV NEWS PROGRAMS. 
20 5 B L Roll-Up CAPTION LINES ROLL UP 
21 5 B L Roll-Up FROM THE SCREEN BOTTOM 
22 5 B L Roll-Up ONE LINE AT A TIME. 

 
Lines 23 and 24: No Need to Do Anything 
 
Lines 25 to the End: Multiple Captions on the Same Screen 
We would like to place the captions of lines 25 and 26 on the same screen--one on the left 
and the other on the right, and at two vertical positions. We will do the same for the 
captions in cells 28/29 and also for 30/31 and 32/33.  
 
We will show you how you can place two captions on the same screen. You need to place 
the desired two captions at different locations on the screen. At the time of sending the 
captions, we will show you how to send both captions at the same time.  
 
Click on the row number 25 and while holding the Ctrl key click on the number 28 
which will highlight both rows 25 and 28. Now click on the Left Position/Left Justify 
button on the tool bar. 
 
You may also accomplish the same result by doing the following: Right-click on any of 
the two cells under the heading H and choose Left position. Now right-click on any of the 
two cells under the Heading J and choose Left Justify. 
 

25 L 13 C Pop-On ¿Dónde está el niño? 
26 R B C Pop-On Está en la casa. 

 
Finally, do the same operation on row numbers 30 and 32. This time simply change the 
vertical position by right-clicking on any one of the 2 cells under the Vertical Position 
“V” and choosing Other position 1.  
 
When you are all done with the script, compare your work with Demo3.cap. It shows you 
the formatted text with placement and attribute information. When you are satisfied with 
your work, you are ready to actually caption your tape.  
 

The Demo3.cap File 
After working with all the cells you will create a file, which should look like this: 
 

Row H V J Display Caption/Subtitle 
1 L B L Pop-On I’M AT THE LEFT 

OFF THE SCREEN 
2 L B L Pop-On SO CAPTIONS 

OF WHAT I SAY 
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3 L B L Pop-On APPEAR AT THE LEFT 
OF THE SCREEN, TOO. 

4 R B R Pop-On NOW I'M AT THE 
RIGHT OF THE SCREEN, 

5 R B R Pop-On SO MY CAPTIONS 
APPEAR AT THE RIGHT. 

6 C B C Pop-On NOW I AM GOING 
OFF-SCREEN 

7 C B C Pop-On TO INDICATE THAT 
I'M OFF-SCREEN, 

8 C B C Pop-On WHATEVER I SAY 
IS ITALICIZED. 

9 C B C Pop-On NOW MY NAME APPEARS 
AT THE BOTTOM OF THE SCREEN, 

10 C B C Pop-On WE PUT CAPTIONS 
OF WHAT I SAY AT THE TOP, 

11 C B C Pop-On SO THAT MY NAME IS NOT 
COVERED BY CAPTIONS. 

12 C B C Pop-On UP UNTIL NOW, WE HAVE BEEN 
USING POP-ON CAPTIONS. 

13 C B C Pop-On WHEN A NEW CAPTION POPS ON, 
THE OLD CAPTION DISAPPEARS. 

14 C B C Paint-On THIS IS A 
PAINT-ON CAPTION. 

15 C B C Paint-On ONE CAPTION BLOCK IS 
PAINTED ON THE SCREEN, 
FROM LEFT TO RIGHT, 16 C B C Paint-On 

ONE CHARACTER AT A TIME. 
17 5 B L Roll-Up NOW THE ROLL-UP MODE. 
18 5 B L Roll-Up THIS MODE IS NORMALLY 
19 5 B L Roll-Up USED FOR TV NEWS PROGRAMS. 
20 5 B L Roll-Up CAPTION LINES ROLL UP 
21 5 B L Roll-Up FROM THE SCREEN BOTTOM 
22 5 B L Roll-Up ONE LINE AT A TIME. 
23 C B L Pop-On Captions can appear 

in lower case, 
24 C B C Pop-On and also in Spanish: 
25 L 13 C Pop-On ¿Dónde está el niño? 
26 R B C Pop-On Está en la casa. 
27 C B C Pop-On And in French: 
28 L 13 C Pop-On Parlez-vous français? 
29 R B C Pop-On Répétez, s'il vous plaît. 
30 C T C Pop-On THE FOLLOWING SPECIAL 

CHARACTERS ARE ALSO AVAILABLE. 
31 C B C Pop-On á é í ó ú à è ì ò ù ä 

ë ï ö ü â ê î ô û 
32 C T C Pop-On THEY INCLUDE THE MUSIC SYMBOL 

AND ACCENTED CHARACTERS. 
33 C B C Pop-On ç ã ñ õ å ¿ ¡ ¢ 

£ ¥ © ® ™ ° ß § 
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Clearing Captions 

If you check the video, you will see a little pause (about a second) in the dialog between 
row 8 and row 9. We will create a blank row to clear the caption on row 8 for a second or 
so. Click the cursor on row 9 and then click on the button  to create a blank row 
between row 8 and row 9. 
 

8 C B C Pop-On WHATEVER I SAY 
IS ITALICIZED. 

9 C B C Pop-On NOW MY NAME APPEARS 
AT THE BOTTOM OF THE SCREEN, 

 
This will create a blank row between rows 8 and 9 as below 
 

8 C B C Pop-On WHATEVER I SAY 
IS ITALICIZED. 

9      
10 C B C Pop-On NOW MY NAME APPEARS 

AT THE BOTTOM OF THE SCREEN, 

 

Step 4: Manual Captioning With and  
Without Time Stamps 
We have provided a videotape to be used with this tutorial. This tutorial text starts at 
about 3.5 minutes from the beginning of the video right after this screen: 
 

Now we will show you 
how CaptionMaker 

software works. 
 
As you view the segment starting at burn-in time code 00:19:55:04, you will see Valerie 
on the left of the screen speaking. We will caption the segment using the following three 
different methods.  
 

Step 4a: Manual Captioning (CPC-600 or CPC-700) 
Using this method, you can send captions to the recording VCR or broadcast out directly.  
 

 
 

1. Make sure the  button on the Time code section (shown below) of the Work 
Area is not in the down position. 
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2. Put the cursor on the row where you would like to begin captioning. 
3. Run the playback and the record VCRs. 
4. When you hear the first word of each cell of text spoken, press the [+] key. The 

caption should appear on the video screen and in the Preview Window 
. 

No time stamps will appear in the Start column. Keep on pressing the [+] key for each 
and every row in the same fashion. Captions will go out and will be recorded in real time. 
You cannot stop in the middle of the video. 
 
If you make a mistake, you do not have the advantage of adjusting time stamps to correct 
it. The tapes must both be rewound and the process must begin again unless you are using 
a video editing system, which can stop both tapes at the same time and restart the tapes 
and resume back to sending captions from that point on. 
 
 
 

Drop Frame NTSC/PAL    If the time code formats on your work tape and master 
tape are different, you may covert them between NTSC and PAL and also 
between drop frame and non-drop frame. See Convert Time Code in “Chapter 8: 
Menus” for details. To convert time codes from one to another (PAL and NTSC 
or drop to non-drop) highlight the time codes you would like to convert and use 
this option to convert them from one to another. 

Step 4b: Captioning with Time Code Reader (CPC-700)  
Using this method, you can assign a time code (using the time code from the video) to 
each caption, and then use Step 5a to do the final captioning. 
 
This is the most professional way to caption. Press the [+] key when the first word of 
each cell of text is spoken in order to capture the time code associated with this word 
(from the Source VCR). It is impossible for a caption to appear at the wrong time, 
provided that you pressed the [+] key at the proper time. If you did not press the [+] key 
at the proper time, it is easy to use time code to correct mistakes. For example, if you are 
captioning and make a timing mistake at 00:02:30:45, you would rewind the tape to a 
point before that time (typically 5-6 seconds) and then play the tape. When the tape 
reaches the point where you made the timing mistake, you would press [+] on the row 
with the caption, which had the incorrect time. Assuming you pressed [+] at the right 
time, your timing mistake would be corrected and you could continue on with time 
stamping the rest of the tape. 
 
Don’t worry about trying to compensate for the amount of time it takes you to react (the 
time between hearing a word and pressing the [+] key). Relax and work at an unhurried, 
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even pace. This time lag can be easily compensated for at a later time, as long as your 
reaction time lag is consistent (e.g., always .5 second late). 
 
There is a file on the disk, Demo.cap that has time codes already associated with the text. 
You can compare your file with this one to check whether you are on the right track. 
 

Step-by-Step Procedure to Capture Time Codes 
From Time code → Properties → Reader menu select your time code reader. If you have 
never installed the software to communicate with the time code reader, the appropriate 
installation routine will walk you through the process at this point. For details see 
Chapter 2. 
 

 
 

1. Make sure the  button on the Time Code section of the Work Area is in the 
down position so that you can to read time code. 

2. Play the Source VCR. 
3. When you hear the first word of each cell spoken, press the [+] key on the far 

right side of the keyboard in order to capture the time code to the Start column. 
The time code at which you press [+] appears in the Time Code Start column  

4. As you press [+], the cursor will move down to the next caption. Press [+] in 
order to send a caption and get the time code for the next caption. Keep on 
pressing the [+] key for the rest of the file in the same fashion. 

 
 

Fine tuning of time codes  If you need to change a time code by small amount, 
click the cursor on the time code cell and press Ctrl+ or Ctrl-. This operation 
with change the time code value by 1 frame.  

 

Correcting Time Code Mistakes 
If you make a mistake with time code, or if you spot a formatting error or typo, you can 
stop pressing the [+] key and fix the formatting, positioning or typographical error. If you 
need to fix the time code, follow the steps below. 
 

1. Rewind the tape to a point just prior to the mistake. 
2. Move the cursor to the place in the text where the error occurred. 
3. Follow Steps 2 to 4 above and continue recording the time codes for the rest of 

the file. 
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Calculate send time for Pop-On  This feature is very important when you caption a 
short commercial. In a commercial, if you add a Pop-On caption at the very 
beginning of the video, you may lose the caption. Since Pop-On captions need 
build-up time to be displayed on a particular frame of the video, you have to make 
sure that the onset of the caption is within the first frame of the video. Right click 
on the first time code under the Start Time column and make sure the send time of 
the first caption is well inside the beginning of the video. 

 

Step 4c: Captioning with PC System Timer (CPC-600 or 
CPC-700)  
Using this method, you can assign a time stamp to each caption using the computer 
system timer and then use Step 5b to do the final captioning. The PC System Timer 
emulates time code – but since it is only an emulation, it is not as effective or efficient as 
using real time code. 
 
The PC System Timer method uses the clock inside the computer as a timing mechanism. 
The work of synchronizing the computer’s clock to the script, however, must be done 
manually, by choosing a reference point on the video before the first caption. The 
reference point could be the beginning of bars and tones or the beginning of theme music 
or something that you can easily identify as a specific point on the video. 
 
Please read Step 4b for time code for a better understanding of PC System Timer even if 
you are not using time code. Working with time code is much simpler than working with 
the PC timer. Time code has a one-to-one correspondence with each frame of the video. 
When using time code method, you do not need a reference point because the time code 
moves forward and backward along with the tape. You can stop time coding any time and 
resume time coding from that point on at any time later. But with PC timer, you need to 
reset the PC timer any time you stop time stamping. When using the PC Timer, you are 
working in real time, which does not move backward with the tape. It moves forward 
only. It never stops. But you can reset the PC System Timer to match the time stamp in 
your caption script at any time using a PC timer reset technique. The reference point 
should appear a row before your first caption.  
 
We are going to use our demo video and use the screen with the following title as our 
reference point. 
 

Now we will show you 
how CaptionMaker 

software works. 
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This title appears at 00:19:55:04 time code and about 10 seconds before Valerie appears 
on the left of the screen and starts saying: 
 

I AM AT THE LEFT OF THE SCREEN 
 

Create a blank row at the beginning of the file and use the time code associated with this 
line as the reference point. 
 

So the first few lines of our demo3.cap file now look like this. 
 
 

1 C B C Pop-On Caption/Subtitle 
2 L B L Pop-On I’M AT THE LEFT 

OFF THE SCREEN 
3 L B L Pop-On SO CAPTIONS 

OF WHAT I SAY 
4 L B L Pop-On APPEAR AT THE LEFT 

OF THE SCREEN, TOO. 
5 R B R Pop-On NOW I'M AT THE 

RIGHT OF THE SCREEN, 
6 R B R Pop-On SO MY CAPTIONS 

APPEAR AT THE RIGHT. 

 
 

Step-by-Step Procedure to Capture PC System Time 
From Time code → Properties → Reader menu select PC System Timer.  
 

1. Make sure the  button on the Time Code section of the Work Area is in the 
down position. 

2. Choose a reference point on the videotape that begins at least 5 to 10 seconds 
before your first caption. Referring to the example in the box above, there is 
more than a 5-second gap between the reference point and the first caption. That 
means during auto-captioning later, you will have enough time to set the 
reference point and then start the AutoSync. If you are a quick typist, five 
seconds is sufficient. 

3. Run the Source VCR. 
4. When you reach the predetermined reference point on the tape (with the cursor 

on the reference point row in your script), press the [+] key when you see or hear 
the reference point.  

5. Continue to the first row of captions. When you hear the first word of each row 
of text spoken, press the [+] key. Timing information will appear under the Start 
column corresponding to the row you just sent out as a caption. As you press [+], 
the cursor moves down to the next caption. Press [+] again to send the next 
caption and get the timing information for it.  
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Correcting Time Code Mistakes 
If you make a mistake, or if you would like to stop time-stamping and take a break, you 
do not have to go back to the initial reference point in order to continue captioning. 
 

1. Rewind the playback tape to a location a few seconds before the point you 
would like to resume time-stamping. 

2. Bring the cursor to the last row you time stamped correctly.  
3. Right-click on the time code cell of that line. A small window will open up. 

Click on the Reset PC Timer to the time code. The PC Timer will be ready to 
reset the clock to the same time as the time stamp on that row. 

4. Run the Playback VCR. 
5. As soon as you hear the first word of that row spoken, press the [+] key to time 

stamp the caption on that row. This action will actually reset the clock to that 
time. Now keep on pressing the [+] key for rest of the file. 

 
 

Fine-Tuning AutoSync     If the captions appear too early, press [Alt] + [-] to slow 
them by one-third of a second. Press it again to slow the display of captions by 
another third, and so on. If captions appear too late, speed them up with the [Alt] 
+ [+] key; the same rates apply. The only sure way to synchronize the time code 
and program is to use time codes on the tape along with the CPC-700. 

Step 5: AutoSync Captioning with Time Stamp  
(CPC-600/700)  
In this step the computer will read the time code or the PC System Timer and send the 
captions automatically, according to the time stamp associated with every caption row. 
To use this step you previously had to perform either Steps 4b or 4c. 
 

Tip   Although Windows is a multitasking operating system, performing other 
tasks (such as checking email) during the AutoSync process is not recommended. 
This is because individual captions might be sent late to the recording VCR if too 
much computing power is being used on tasks other than captioning. 
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Step 5a: AutoSync Captioning with Time Code (CPC-700 
only) 
 

1. Make sure the  button on the Time Code section of the Work Area is in the 
down position. 

 

2. Rewind the playback tape to the beginning. 
3. Run the playback tape and the recording tapes. 
4. Click on the Caption → AutoSync menu option or on the AutoSync button in the 

toolbar to start automatic captioning. 
 
The word AutoSync in the status bar will start flashing. Editing features of the program 
will not be accessible until the AutoSync task is finished. Click again on the AutoSync 
button to stop the job. 
 

Adjusting Time Cue to Correct Human Reaction Time   When you press the [+] 
key to record the time stamp, there is always a possibility of an error of few 
frames. The source of the error is the reaction time from the time you hear the 
first word spoken until the time you press the [+] key. Assuming it is always a 
consistent error, you can change the time stamp of all the rows by a few frames 
using the Ripple time code option. Left-click on the Start column header to 
highlight all the time cues, and then right-click on the time code cell of the very 
first row and choose Ripple time code. Now you can enter the new time cue (a 
few frames more or less than the time cue of the first row) to replace the time cue 
of the first row and ripple the time cues for the whole file. 

Step 5b: AutoSync Captioning with PC System Timer  
(CPC-600 and CPC-700)  
 

1. Make sure the  button on the Time code section of the Work Area is in the 
down position. 

2. Rewind the playback tape to the beginning.  
3. Right-click on the time code cell of the row with the reference point. A small 

window will open up. Click on Set System Timer to Current Start Time. The PC 
Timer will reset to the same time as the time stamp on that row 

4. Run both playback and record VCRs. 
5. As soon as you see the Reference point on the video, click on the AutoSync 

button or Caption>AutoSync menu in the toolbar to start automatic captioning. 
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The word “AutoSync” will display in the middle of the status bar. You cannot access any 
of the editing features of the program until AutoSync is finished. Click again on the 
AutoSync button to stop. The system will then automatically insert captions into your 
tape. 
 
Note that VCR motors do not always run at exactly the same speed. A consequence of 
this is that captions may become slightly out of sync with the dialog on a long video 
when using AutoSync. 
 

TIP FOR FORMER DOS CAPTIONMAKER USERS: Final AutoSync   Former DOS users 
will note that the cursor no longer needs to be on a specific place in the text in 
order to start AutoSync. In fact, if you rewind or fast-forward the VCR while 
AutoSync is on, the CaptionMaker will read the time code and pick up AutoSync 
from any place in the file.  

Two Captions Appearing Simultaneously 
You may wish to have two or more captions appear on the screen at once, but in different 
positions (the top and bottom of the screen, for example). The need for this may arise in a 
program where two people say different things at the same time. If you have two captions 
with the same Start Times, both will appear on the screen simultaneously. The easiest 
way to do this is to skip over one of the rows while assigning time code, and later cut and 
paste the Start Time from the row where you did assign time code to the row that you did 
not assign a time code to. Of course, you should assign different positions to these 
captions so they will both be visible. 
 

Tip   You may use the function Same Start Time to assign same time code to 
multiple rows. Highlight multiple rows with time code, right-click on any 
highlighted row and then click on Same Start Time. 

Captioning Two Languages on the Same Video 
CaptionMaker can use used to caption two languages on the same video in a limited way.  

With ITV-Injector/DV-2000/DV-3000 
CPC distribution CD contains a utility software CaptionMerge. First create two 
CaptionMaker .cap files for two languages. Then export two files to Ultech DV2000/ 
DV30000/ITVInjector (*.ult) file format. 
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Now run CaptionMerge software and do the following: 
  

♦ Choose the first file for CC1 and 
♦ Choose the second file for CC2 to CC3 
♦ Choose CC2 or CC3 for the second language  
♦ Choose the final Destination (merge) ULT file 
♦ Finally, click on the Merge File button 
 

Use this final .utl with the DV2000/ItvInjector.  
Make sure you have DV2000/ItvInjector software version 3.5 or higher. 
 

Note:  Channel 1 and Channel 2 occupy the same space inside the Field 1. The 
same is true for Channel 3 and Channel 4. When you caption two channels in the 
same field, there is always fight with the space between CC1 and CC2. CC1 has 
the first priority. Whatever space is left, is used by CC2. It is good idea to para-
phrase the text and make it short in both languages when you do CC1 and CC2 
caption simultaneously. 

 

With Other Encoders 
Using one computer  
You can caption in CC1 or CC2 (Field 1) in one pass and then run the captioned video 
through the encoder and caption CC3 or CC4 (Field 2) in the second pass. Make sure the 
option Allow existing filed 1 data pass through untouched under the Caption > Caption 
Properties > Control menu is checked. 
 
Using two computers 
You can caption a video in CC1 or CC2 (Field 1)and CC3 or CC4 (Field 2)  at the same 
time.  
 
The encoder must be connected to two computers via  

1. a serial cable or a  modem, 
2. 2 serial cables, or 
3. 2 modems 

Invoke the Caption → Device → Properties option. 
 
 
You have to make sure that you set the following items properly.  

1. Channel (C1, C2, C3 or C4) 
2. Allow existing field 1 (or 2) data to pass through untouched. 
3. Send caption data if available box is checked. 
4. Caption 2 or more channels – send init code for each line box is checked. 
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In the previous dialog box, CPC is set to caption in Channel 3 (field 2) under one of the 
following two situations:  

1. caption data is sent to the encoder  in channel 1 simultaneously via a modem or a 
serial cable or,  

2. the video is already captioned in channel 1  
 
A few important points to note: 
You can have either of the following situations: 

1. Both computers running CaptionMaker software or 
2. One computer running CaptionMaker and the other computer running another 

captioning software. 
 
You may mix and match any of the two methods of captioning: 

1. Live or Realtime or,  
2. Live Display or,  
3. Post Caption. 

 
In Live Realtime method, you can use either a steno machine or a Speech Recognition 
software to send the caption live. 
 
In Live Display method, you have to have the text prepared already. Then you can send 
the captions by pressing the (+) key in real time by listening to the dialog. 
 
If you have access to the time code of the video, you may use the Post Caption method. 
You must have a already prepared time stamped file. Then you can invoke the AutoSync 
function and captions will go automatically synchronized with the video. 
 

Note: You cannot caption Channel 1 and Channel 2 simultaneously using this 
technique since both Channel 1 and Channel 2 occupy the same space inside the 
Field 1. The same is true for Channel 3 and Channel 4. 

AutoSync Error Checking 
If this option Caption > AutoSync Error Checking is checked, CaptionMaker will go 
through the whole file and make sure there is no missing time codes or the time codes not 
in ascending order before starting AutoSync. It is a good idea to have this option 
checked. That way for a long video you do not have to wait for long time until the error is 
caught and AutoSync stops at that point. 
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Error Checking  
If this option Caption > AutoSync Error Checking is checked, CaptionMaker will go 
through the whole file and make sure there is no missing time codes or the time codes not 
in ascending order before starting AutoSync. It is a good idea to have this option 
checked. That way for a long video you do not have to wait for long time until the error is 
caught and AutoSync stops at that point. 
 

 
 

Final Checking 
This is a very important function to check all timing and formatting errors before you do 
the final encoding. The option is available under Caption > Final Checking menu and 

also can be accessed by clicking on the  icon at the top left corner of the screen. You 
can set your favorite parameters on the following window and check for errors after 
preparing a caption file and before using that file for encoding or any other purposes.  
 
When you invoke this option you will see a dialog box below where you may choose 
options related to time code tolerance, reading speed of captions, maximum characters 
per line, unacceptable characters for captioning, etc. 

Timing Errors Settings 
When you caption a video, it is very important that you conform to maximum WMP for 
caption, depending on your audience. Similarly, it is customary not to have a Pop-on 
caption covering a shot change. And finally, if you do not give enough time for a Pop-on 
caption to build-up, the caption would not appear at the desired time you assigned. For 
Pop-on captions, it takes about a second for every 50 characters of text. If the difference 
of time codes of the previous caption and this caption is less than 1 second for a caption 
of 50 characters, the caption will appear little later than the assigned time code. To check 
all these errors on the fly, you can invoke the option under Caption> Timing Error 
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Settings menu. You can check any one of the following items and assign different colors 
for each error in the following dialog box. 

Find Shot Changes 
 
You can find the shot changes in any video (wmv, avi, mov, mpeg, m2v etc.). It is a good 
idea not to have a shot change inside the duration of any caption in Pop-on mode. Try to 
place the caption after a shot change or finish displaying a caption before a shot change 
occur. It is more for esthetic purpose. 
 
After you open caption file with the appropriate video file, to find the shot changes, click 
on Tool > Find Shot Changes. 
 
It will take a while depending on the length of the video to find the locations of all the 
shot changes. When you save the caption file, the shot change information will be saved 
in the .cap file. So when you open the .cap file again later, you do not need to find shot 
changes again. 
  
After finding the shot changes, when you play the video, the next shot change indicator 
appears right below the Time code display in HH:MM:SS:FF format. Next shot change 
display color becomes RED when it is less than 10 seconds from the next shot change. 
 

You can also click the two buttons ( ) next to the time code display area to move 
to the previous and next shot change locations. 

Digital Video: CPC-700NL/700NLE 
The CPC-700NL/700NLE comes with all the features of the CPC-700, plus additional 
exciting features that make it easy to caption a video from your hard drive. This section 
will guide you through the process of captioning a video from your hard drive. 

VTR Control with VPedal inside CaptionMaker You can control (play, pause, fast 
forward, rewind etc.) a digital video file using vPedal foot pedal controller 
(www.vPedal.com). One interesting feature of the vPedal foot controller is the 
"release back" function which is available under VTR Control >> vPedal menu 
option. Release back time is user selectable. 

Once the Play button on the VTR Control) is first clicked, you will be able to use 
the Pause function on the pedal to toggle between Play and Pause but the first 
time you play the video, you must start it manually by clicking the mouse on the 
Play button. 
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Capturing Video on a Hard Drive 
If you are planning only to caption a videotape, bringing your video from the tape to the 
hard drive and then back may not be necessary. However, if you would like to do a 
webcast or make a DVD, or if you just don’t want to put all that back-and-forth strain on 
an expensive VCR, then it is a good idea to bring your video from tape to the hard drive.  
 
Unless you have your own video capture device, you may a device like Dazzle DVC-80 
to capture video from a videotape. DVC-80 comes with the MGI VideoWave software.  
The following instructions apply to the MGI VideoWave software, which also works 
with the ATI All-In-Wonder and the Osprey100. 
 

1. Connect all the cables from the VCR to the Dazzle DVC 80.  For audio, connect 
the Left Audio channel.  

2. Start MGI VideoWave 4.0 by double-clicking on the shortcut icon on your 
desktop or from Start → Programs → MGI VideoWave 4 →MGI VideoWave 4. 

3. Press File → New or click on the New Production icon  on the top left 
corner. 

4. Press the Capture icon  on the left to see the video playing from the VCR. 
5. Press the Settings… option next to the Start Capture box 

 
 
 
 

6. If you are using a video capture device other than the Dazzle, change the Capture 
Device fields to your brand of capture device. Choose Video Composite as Video 
Input and NTSC or PAL video of your choice. 

 
7. Go to the Video Template tab and click on the Create button.  

 
8. Enter avi with Mpeg2 or Mpeg4 compression to reduce the size of the video and 

press Next.  
 

9. Next choose 29.97 fps. It is important to use 29.97 frames per second because the 
CaptionMaker’s Video Playback time code uses drop-frame time code.  
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10. Now choose CD quality  for the audio and press OK.   
 

11. Click on the Video + Audio button on the bottom of the screen to start capturing 
the video. When you click on Stop, a dialog box will open up, asking you the 
name of the file you just captured. Enter a name and specify a folder to finish the 
capture process.   

 
You may want to convert the .avi file into an .rm file, a .wmv file, or a .mov file. This is 
only necessary to decrease the file size if you are planning to webcast the file, and the 
.wmv or .rm file will not play in the CaptionMaker software. Detailed instructions are 
given in the webcasting section of this manual as to how to convert the files to the desired 
file type. 
 
The following test was run with External Dazzle DVC80 using the accompanying 
software MGI VideoWave 4 on Pentium II 450MHz with 512MB SDRAM: 
 

Video Length Compressed Avi .avi .rm 
1 minute 9MB 272MB 0.6MB 

 
As you can see, the one-minute video’s compressed .avi file is 1/30th the size of the 
uncompressed avi file. A compressed .avi is ideal for captioning. Its size is small enough 
to be used on a personal PC, but it still maintains a high quality and plays at 29.97 frames 
per second. CPC-700NL/700NLE can play wmv, avi, mpeg, mpeg2 and mov files.  
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Open Video File in CPC-700NL/700NLE  
Click on the  Video Camcorder icon located in the Preview Window area. A dialog 
box like the one below will open. 
 

RealOne video CaptionMaker relies on Windows engine to play all video files. At 
the time writing this manual, WMP does not play rm files. As a result, 
CaptionMaker can’t play RM, or Real Media files. To open a .RM file, you may 
install a third party software which allows WMP play a .RM videos and then you 
can open a RM file in CPC. You may download the software from  
www.free-codecs.com/download/Real_Alternative.htm.  
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Make sure that you unselect the Enable external video from tape button, but leave 
Display rendered caption/subtitle selected. Select Enable video file playback from disk 
and make sure Play video file during AutoSync/AutoPreview is selected (unless you are 
planning to use a video feed from a USB device for AutoSync only). Click the Browse 
button. Find the video file on your hard drive, and then click Close.  
 

QuickTime Movie: CaptionMaker made a special effort to play QuickTime mov 
even though WMP can t play MOV files. You have to check the box for 
QuickTime files when you open the video. 

 
Read and use actual TC values in the file 
Checking this box will read the actual TC from a digital video (Mpeg and DV), if and 
only if the digital video was recorded with TC in special TC area of the video file. 
Normally digital videos do not have internal timecode. 
 
Unless CaptionMaker reads internal time code of a digital (Mpeg & DV) video, it assigns 
00:00:00:00 to the first frame of the video and then counts the frames and assigns 
timecodes to any frame according to drop frame (29.97 fps) or Non-drop frames (30 fps). 
 
Temporarily set TC reader to “Video Playback” 
If you normally use a timecode reader to read timecode from a video tape, you can check 
this box to read timecode for a video file. This way, later on when you choose to play 
video tape, you will fall back to your choice of timecode reader. 
 
Video file frame rate 
Most digital videos are created at 29.97 frames/second (drop-frame). Unless you know 
that the video was created at a different frame rate, use 29.97 fps for the Video file frame 
rate. 
 
Enable Offset 
Checking this box and assigning a desired timecode value, you can match the burn in 
timecodes of a digital video when you playback the video. Adding an offset will add the 
offset value to the timecode when it is displayed.  

Digital Video Time Code 

Go to Time Code → Time Code Reader Properties menu or simply click on the  icon 
in the Time Code bar to open up the Time Code Reader Properties. Once there, select 
Video Playback from the drop-down menu. Now you can assign time code to the 
captions. See Step 4b: Captioning with Time Code Reader (CPC-700) earlier in this 
chapter to learn how to break the script into individual captions and time stamp the script 
to synchronize the captions with the audio. 
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CaptionMaker counts the frames of digital video and convert them to SMTE time codes. 
If you use a Mpeg2 video, CaptionMaker can read embedded time codes in Mpeg2 video 
too. To read time codes directly from the video you need to click on  Scan Playback File 
for Time Code Info. 

Video File Automatic Shuttling 
You can automatically shuttle the video file to the time code of the selected row. When 
enabled and you click on a row, the video file quickly moves to the start time code of the 
row you clicked on. 
 
This feature is only enabled under the following conditions: 

♦ When the “mark time codes on send lines” feature is enabled (via the “time code” 
menu or the icon in the “time code” display section of the program). 

♦ When a video file is loaded and enabled during editing, and it is stopped (not 
playing and not paused). 

Note: If you do not like this feature and like to turn it off, you may uncheck the 
item Enable Video Auto Shutting from the Time Code menu. 

Drop Frame vs. Non-Drop Frame Time Code 
There is no time code track on the A/V file. CPC keeps track of the video frames starting 
with 00:00:00:00 time code for the first frame of the video and keeps a frames counter 
that counts 29.97 frames per second (on average). The exact counting mechanism is bit 
more complex. This is exactly the same way drop frame time code is used for videotape 
format. That’s why the time code from the Video Playback acts in the same way as the 
drop-frame time code does for a videotape format. If you have a video file on the hard 
drive that is exactly one hour long according to the clock on your wall, the very first time 
code of the first frame of the video is 00:00:00:00 and the time code of the very last 
frame of the video is exactly 01:00:00:00. On the other hand, the time code of the very 
last frame will be 00:59:56:12 for Non-Drop frames. There is difference of 00:0:03:18 
frames. 

Video File Time Code Offset 
 
This option allows you to specify the time code value for the first frame of a video file 
selected for play back. If you have a digital video with burn-in time code, you can adjust 
the time code offset matched with the time code of the first caption. This way, the time 
code displayed in the time code display window and time codes for the captions with 
match with the burn-in time code. 
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Going Back to Videotape Format for Reference 
There are number of reasons you may need to go back to the videotape format from 
which the video on the hard drive has been created. They include the following: 
 

♦ Captioning a videotape using a closed caption encoder or subtitling using a 
character generator 

♦ Captioning/Subtitling a DVD 
 
There are two issues when you need to go back to videotape format after the time-
stamped file has been created using video from the hard drive. 
 

1. Matching the time code from the video on hard drive to time code on the 
videotape  

2. Drop frame vs. non-drop frame  
 
If you are going to do the following, you do not need to go back to the videotape format 
 

♦ Captioning/Subtitling a video for webcast 
♦ Captioning video residing on a NLE system 

 

Matching A/V Time Code to Videotape Time Code 
When you work with the video on the Hard Drive, the start time code is always 
00:00:00:00. On a videotape, it is very unlikely that the starting time code will be 
00:00:00:00. So it is necessary to “match” the time code from the videotape with the time 
code from the video on the hard drive. 
 
There are two preferred methods for doing this.  
 

1. The easiest way is to originally put visible burnt-on time code (at the top left 
corner) onto the videotape before converting the A/V to an A/V file. Then 
matching the time code of the A/V file and the actual time code from the 
videotape format is very simple. You can simply move through the video on the 
hard drive slowly, frame-by-frame until you find the burnt-on time-code for the 
very first caption. 

 

2. The other method is slightly more complicated. It involves finding the actual time 
code of the first caption directly from the videotape. Some tape decks have digital 
time code readouts. You may get the time code for the first audio, which is 
captioned from the readout display by playing the tape and pausing the tape at the 
onset of the first audio. Or you may use the CaptionMaker software to get the 
time code from the videotape as long as you have a time code reader in the 
computer running CaptionMaker software. 

 
After noting the time code of the first caption from the videotape, you are ready to match 
the time codes on the file you created from the video on the hard drive.  
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1. Highlight the time code column by clicking on the Start header of the time 

code column 
2. Right-click on the first caption and select Ripple Time Code. 
3. Enter the burnt on time-code shown in the preview window.  

 
This will ripple all the time codes starting with the true time code of the videotape. 

Drop Frame vs. Non-Drop Frame 
If you have to go back to the videotape format with non-drop frame time code, you need 
to convert all the time codes to non-drop frame time codes. Go to Time Code → Convert 
Time Code menu. Choose the option to convert from drop frame to non-drop frame. 

The Final Step  
Once you have prepared the script with time code for the video on the hard drive, you 
have a number of different options, depending on the type of media you would like for 
your final product. Here are a few examples, which are described in details for different 
media. 

Captioning a Videotape with Drop-Frame Time Code  
You would like to caption a videotape that uses drop-frame time code. In this case the 
only thing you need to do is to “match” the time code from the videotape with the time 
code from the video on the hard drive by following the procedure above. Now you are 
ready to use the file you have prepared to encode the captions onto the videotape. Follow 
the steps in the section below, “Encoding Videotape Using a Time Code Reader and an 
Encoder”. 

Captioning a Videotape with Non Drop-Frame Time Code 
If you would like to caption a videotape that uses non-drop frame time code, you need to 
first “match” the time code from the videotape with the time code from the video on the 
hard drive by following the procedure above.  
 
Then you have to convert the drop frame time code to non-drop frame time code. Go to 
Time Code → Convert Time Code menu. After converting from drop frame to non-drop 
frame, you are ready to use the file you have prepared to encode the captions onto the 
videotape following the steps in the next section. 

Encoding Videotape Using a Time Code Reader and an Encoder 
To switch back to see the video from the tape format and to choose the appropriate time 
code card and encoder, follow these steps: 
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1. Click on the  Video Camcorder icon located in the Preview Window. 
2. Unselect Enable Video file playback from disk and Play video file during 

AutoSync.  
3. Select Enable external video from tape. 
4. Click on Caption → Device and choose the appropriate closed caption 

encoder.  

5. Finally, click on the  icon in the Time Code bar to open up the Time Code 
Reader Properties dialog box and select your original time code reader card 
from the drop-down menu.  

 
You are ready to AutoSync and caption the videotape using a time code card and a closed 
caption encoder as done by the CPC-700 CaptionMaker software. 

Caption/Subtitle a DVD 
For a DVD, the process is the same as the process described above. You must “match” 
the time code (from the videotape you will use to make a DVD) to the time code you 
prepared using the video from the hard drive. You should also make sure the time code 
on the video is drop frame, otherwise you must convert the time code to non-drop frame 
following the steps described earlier. Once you have done this, you are ready to export 
DVD caption or subtitle files for your DVD authoring system. 
 
For captioning, click on Caption → Device, choose Generic Encoder. Then click on File 
→ Export, choose the group Caption Formatted and then select your DVD authoring 
system. 
 
For subtitling, click on Subtitle → Device and select your DVD Authoring System. 
Using the font icon in the Preview Window toolbar, choose the desired font attributes and 
then click OK. Then go to File → Export and select the group DVD/DVD2000/Webcast 
Subtitle radio button. Choose your DVD Authoring System and continue. Once you are 
done, import the exported CPC files into your authoring system for subtitles.  
 
Please consult the Subtitling Chapter for a detailed step-by-step tutorial to caption and 
subtitle DVDs. 

Caption a Video Using an NLE System With CCaption 
Go to File → Export and choose the Caption Formatted radio button, then select 
CPC/Leapfrog CCaption(*.onl) or CPC-715 Online Caption (*.onl) from the drop-down 
menu. Enter a file name and click on Finish.  Now you must import this file into 
CCaption-NLE. The instructions differ depending on which NLE you have, so it is best to 
consult the CCaption manual at this point.  
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Caption a Video Using an NLE System With 700NLE 
To caption/subtitle digital video using CPC-700NLE, check the chapter on CPC-700NLE 
for details. 

Caption a Video for Webcast 
For this process you must first choose the type of online media player you would like to 
use (RealPlayer, Windows Media Player, or QuickTime).  
 

• Once you have chosen a media player and you have a compatible file for it, go 
to File → Export and select the DVD/DV2000/Webcast radio button.  

• Then choose the desired file type from the drop-down menu.  
• Name the file and click on Next. The dialog box will offer different options 

depending on the selected media player.  
 
Please consult the Webcasting section of this Manual for detailed step-by-step 
instructions. 
 

Caption Tips  

Suggestions for Breaking Lines 
Watching captioned programs on television will show you how professional captioning is 
done, including breaking text into individual captions, positioning the captions and use of 
time sequencing. You will notice that many times professional captioners adjust the 
timing of the captions to give uniform readability.  
 
Various signs indicate that text needs to be broken into separate captions.  
 

1. End a caption at the end of a sentence. The import file option can make these 
breaks automatically (“.”, “?”, and “!”) 

2. End captions at commas and semicolons if they come at a natural pause in the 
dialog and conclude a phase. The import file option can make these breaks 
automatically as well, but there are many commas in English that are NOT good 
places to break text. 

 
However, when you break text into individual captions, they should make grammatical 
sense. Here is an example: 

Unformatted, Raw Text: 
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On the way to the airport, I got caught in 
traffic and ended up being late for my 
flight. I had to wait around for five hours 
to catch the next available flight. 

 

A poor way to caption it: 
On the way to the airport, 

I got caught in  

traffic and ended up being late 
for my flight. I had to wait 
around for five hours to catch 

the next available flight. 

 

A good way to caption it: 
On the way to the airport, 
I got caught in traffic 

and ended up being late 
for my flight. 

I had to wait around 
for five hours 

to catch 
the next available flight. 

 
 
We will go over some basic captioning guidelines. The first basic convention concerns 
the difference between how you represent on-screen and off-screen speakers. The words 
spoken by off-screen speakers (commonly narrators) appear in italics (but italics can be 
skipped if the speaker comes in and out of view). The words of on-screen speakers appear 
in the normal (roman) font.  
 
The next convention concerns centering and non-centering. Captions indicate the location 
of the speaker, and should appear under the speaker. However, if centering the caption 
interferes with a graphic and/or important on-screen visual information, then the caption 
should be moved to another location. 
 
The main objective is to have each caption represent a single thought. There is no single 
right way to caption a video, but a few additional guidelines may help: 
 

1. Your captioning style should be consistent throughout the video. 
2. Whenever possible, you should break captions into logical phrases. Captions 

randomly broken up may convey a different meaning than intended.  
3. Captions can indicate the location of the speaker. For instance, a caption on the 

left side of the screen will indicate the speaker is on the left, while a centered 
caption shows that only one person is speaking throughout a scene. 

4. Words can be emphasized with underlining. 
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5. Use Attribute → Insert Music Symbol to place a musical note at the beginning and 
end of musical lyrics. Never paraphrase lyrics. Use the title of the song when 
possible. 

6. Indicate sound effects in parentheses in lower case: (boom), (applause). 

Suggested Caption Styles from CMP & WGBH  
 
Caption Media Program (National Association of Deaf) has created a style guide, which 
is available from www.cpcweb.com/dowload/CaptionKey2005.pdf. This is a very helpful 
guide to understand the styles and conventions used to caption a video. We strongly 
encourage you to read this document before producing captioned video. 
 
The Media access group at WGBH Boston publishes a guide called “Suggested Styles 
and Conventions for Closed Captioning.” It is available from:  
 

Media Access Group at WGBH  
125 Western Avenue 
Boston, MA 02134 
(617) 300-3600 V/TTY 

 

http://main.wgbh.org/wgbh/pages/captioncenter/ccstyles.html 
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